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NEW QUESTION 1
- (Exam Topic 1)
A guest asks about the start time of a specific scheduled event and wants to know what the snow conditions will be like during their stay.
You need to determine how to design the chat solution to answer those questions. What should you do? To answer, select the appropriate options in the answer
area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated
Box 1: Load the extracted topic into a variable
Power Virtual Agents uses entities to understand and identify a specific type of information from a user's responses. When saving the identified information to a
variable, a variable type will be associated with it. The variable type is analogous with the entity.
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 2: Create a custom entity
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 2
- (Exam Topic 1)
You need to design the resort portal to meet the business requirements. Which data source should you use?

A. Microsoft Excel
B. Azure SQL Database
C. SQL Server
D. Common Data Service

Answer: A

NEW QUESTION 3
- (Exam Topic 1)
You need to design the chat solution to answer the inquiry from Guest1.
Which three components can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Variables
B. Escalations
C. Smart match
D. Synonyms
E. Topics

Answer: ACD

Explanation: 
Scenario: Guest1 inquires about snow conditions several times during each day of their stay.
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
Synonyms allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even
smarter.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 4
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- (Exam Topic 1)
You need to design the resort portal's email registration process.
Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 5
- (Exam Topic 1)
You need to design the guest check-in solution.
Which technologies should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
You need to design the guest check-in solution.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Canvas app,
Power Apps mobile app
https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/offline-apps

NEW QUESTION 6
- (Exam Topic 2)
You need to address the executive’s concerns regarding unnecessary data access.
Which security changes should you make? To answer, select the appropriate options in the answer area.
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NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Assign records to a service account and add the team member doing the verification by using an access team.
When to use access teams
* The teams are dynamically formed and dissolved. This typically happens if the clear criteria for defining the teams, such as established territory, product, or
volume aren’t provided.
* The team members require different access rights on the records. You can share a record with several access teams, each team providing different access rights
on the record. For example, one team is granted the Read access right on the account and another team, the Read, Write and Share access rights on the same
account.
* A unique set of users requires access to a single record without having an ownership of the record. Box 2: Assign records to the QV team when the service
request is completed.
Issues: More employees than are required can access individual client information and continue to have access after a service request is completed.
Management has decided to create a new qualification verification (QV) role to help ensure that clients get the most accurate results. This role examines
completed work to ensure that nothing is missed.
• When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all
the qualifications related to their service requests.
Reference:
https://docs.microsoft.com/en-us/power-apps/developer/data-platform/use-access-teams-owner-teams-collaborat

NEW QUESTION 7
- (Exam Topic 2)
You need to coordinate updates and deployment for managed solutions containing completed work without disrupting the system.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Deploy a patch with the changes made from the current solution. Scenario:
The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live
date without the other shared components.
Box 2: Deploy a full copy of the original solution using the upgrade option. Then, deploy the new solution by using the update option.
Scenario: All components required for the verification process must be included in a new solution. Corporate security requires that deployments to non-
development environments must be automated using
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service accounts.
Managed solutions are used to move customizations from the development environment to other higher-level environments. These solutions are created and
maintained by the power users and provided to internal IT for deployment when they are ready.
Note:
Upgrade This is the default option and upgrades your solution to the latest version and rolls up all previous patches in one step. Any components associated to the
previous solution version that are not in the newer solution version will be deleted. This is the recommended option as it will ensure that your resulting configuration
state is consistent with the importing solution including removal of components that are no longer part of the solution.
Update This option replaces your solution with this version. Components that are not in the newer solution won't be deleted and will remain in the system. This
option is not recommended as your destination environment will differ in configuration from your source environment and could cause issues that are difficult to
reproduce and diagnose.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/update-solutions

NEW QUESTION 8
- (Exam Topic 2)
You need to assign 10 percent of the Qualification records to the QV queue through table configuration by using a Power Automate flow.
What should you do?

A. Create an autonumber column on the Qualification table and assign its qualification records if the number cleanly divides by 10.
B. Create a calculated column on the Service Request table that sums the number of qualification records, generates a random number between zero and the
number from the new field, and assigns each qualification record if the number generated is 10 percent or less of the value of the new field.
C. Create a roll-up column on the Service Request table that is the count of qualification records, generates a random number between zero and the number from
the new field, and assigns each qualification record if the number generated is 10 percent or less of the value of the new field.
D. Create an autonumber column on the Service Request table and assign its qualification records if the number cleanly divides by 10.

Answer: B

NEW QUESTION 9
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator.
Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Excel template
B. Entities component of a solution
C. Microsoft Virtual Studio
D. Templates area

Answer: B

Explanation: 
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables

Expand Data, select Tables, select the table you want, and then select the Views area.

 On the toolbar, select Add view. Add view to table

 On the Create a view dialog, enter a name and, optionally, a description, and then select Create. Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 10
- (Exam Topic 3)
A company plans to implement chatbots by using Power Virtual Agents. The company has the following requirements for the bots:
• Users in the accounting department must be able to create a bot for frequently asked questions.
• The support desk users must be able to use the bot.
The users must not be able to change environment parameters in the Microsoft Power Platform environment. You need to configure the permissions for the bots.
Which actions should you implement? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 10
- (Exam Topic 3)
You are creating tables for use with Microsoft Power components.
The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?

A. Power Apps
B. Default solution
C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C

NEW QUESTION 14
- (Exam Topic 3)
You are a consultant. A client asks you to remove several solutions in one of their Microsoft Dataverse environments
The client wants to know what effect removing the solutions will have on the rest of the system. You need to explain the results of removing the solutions.
Which components be affected? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 16
- (Exam Topic 3)
You are a Dynamics Sales administrator for a car dealership. The dealership uses only out-of-the-box functionality. When a new car is sold, the salesperson uses
a Word template to generate a letter from the quote to thank the customer.
You need to determine if you can revise the template. Which Word template change can you make?

A. Add the Discount field conditionally.
B. Format the table to have alternating color rows.
C. Format the Created On field to a long date format.
D. Add the address of the customer.D18912E1457D5D1DDCBD40AB3BF70D5D
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Answer: D

NEW QUESTION 18
- (Exam Topic 3)
A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.
This app needs to be promoted to the user acceptance testing environment.
You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.
B. Set the Optimized embedding appearance field to true.
C. Publish all changes.
D. Run the solution checker.
E. Clone a solution.

Answer: DE

Explanation: 
The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.
The solution checker analyzes these solution components: Common Data Service plug-ins
Common Data Service custom workflow activities
Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps
Reference: https://www.eimagine.com/ui/

NEW QUESTION 19
- (Exam Topic 3)
You are creating a Power Virtual Agents chatbot that uses multiple topics. Each user interaction can reference more than one topic.
You need to be able to capture a value in an initial topic and use it in subsequent topics. Which type of variable should you create?

A. Bot
B. Topic
C. Context

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot

NEW QUESTION 24
- (Exam Topic 3)
A company has a canvas app that includes the following screens: Screen1 and Screen2. The OnVisible property for Screen1 contains the following expression.
Set(AgeGroups, ["1-25", "26-54", "55+"])
For each of the following statements, select Yes if the statement is true. Otherwise, select No. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 29
- (Exam Topic 3)
You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:

The form must do the following:
• The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.
• The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.
You need to configure the app with the least amount of effort.
What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface Description automatically generated with low confidence

NEW QUESTION 34
- (Exam Topic 3)
A company uses a canvas app.
Supervisors must approve transactions when a user from the sales department enters a revenue amount that is over $1 million.
You need to configure an approval process without using code. What should you create?

A. Column Expression
B. Power Automate cloud flow
C. Azure Service Bus service
D. Power Apps component framework (PCF) control

Answer: B

NEW QUESTION 37
- (Exam Topic 3)
A company creates a Power Virtual Agents chatbot.
You need to determine when live agents are engaged to provide support.
Which metrics should you use? To answer, drag the appropriate metrics to the correct processes. Each metric may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/teams/analytics-summary-teams

NEW QUESTION 39
- (Exam Topic 3)
You are examining several processes to determine if you can automate the processes by using Power Automate.
The processes must run without human intervention when possible.
You need to determine which flow type should be used for each process.
Which flow type should you use? To answer, drag the appropriate processes to the correct flow types. Each process may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text Description automatically generated
Box 1: Attended desktop flow
Desktop flows are used to automate tasks on the Web or the desktop.
To run an attended desktop flow, you need to have an active Windows user session that matches the name of the user configured for your connection.
Note: Web applications are critical components of most organizations, and they are commonly used to access data from servers.
Most CRM and ERP platforms run through web browsers, while the most popular business productivity tools are web services. Web applications are
unquestionably an integral part of the technological infrastructure of most companies.
To provide automation solutions for these applications, Power Automate Desktop supports all major browsers through its web automation actions.
Box 2: Unattended desktop flow.
Unattended desktop flows are best for applications that do not need human supervision. References:
https://docs.microsoft.com/en-us/learn/modules/pad-web/1-introduction
https://docs.microsoft.com/en-us/power-automate/desktop-flows/run-pad-flow

NEW QUESTION 42
- (Exam Topic 3)
A company is training an Al model using a custom table to determine the amount of time it takes to deliver a package based on several key fields.
The testing data used to train the model is used for all training and regression testing scenarios and is considered complete data.
The trained model predicts a 2 percent variance between the estimated delivery time and the actual delivery time of packages.
The executive sponsors reject the model because the actual variance is at 15 percent. You need to address the sponsors' concern
What should you do?

A. Reduce the size of the data used within the model.
B. increase the size of the data used with the model.
C. Use sample training data from Microsoft
D. Replace the training data with real-world data.

Answer: D

Your Partner of IT Exam visit - https://www.exambible.com 



We recommend you to try the PREMIUM PL-200 Dumps From Exambible
https://www.exambible.com/PL-200-exam/ (211 Q&As)

Explanation: 
Note: Start using AI Builder with sample data
Don't have any data of your own to create a model? No problem! We've got you covered.
Sample data is available for several AI Builder model types, together with instructions for working with the sample data.
Reference: https://docs.microsoft.com/en-us/ai-builder/samples

NEW QUESTION 46
- (Exam Topic 3)
A company has employees in France, Mexico, and the United States. You are creating a Power Apps app to allow users to add client records to Microsoft
Dataverse. The default language for the company is English.
The company wants the app to display each local language. You need to add the Spanish and French languages.
Which four actions should you perform in sequence for each language? To answer, move the appropriate actions from the list of actions to the answer area and
arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Select an unmanaged solution. Export the localizable text
The scope of the localizable text that will be exported is the unmanaged solution that contains the localizable text.

 From Power Apps, select Solutions.

 In the All Solutions list, select the unmanaged solution that contains the localizable text you want.

 On the command bar, select Translations > Export Translations.
Step 2: Export translations.
Step 3: Add a language code column and a translated wording in the CrmTranslations.xml file. Get the localizable text translated
You can send this file to a linguistic expert, translation agency, or localization firm.
If you have the knowledge to translate the text, or if you just want to see the format, you can extract the zip file that you exported you will see that it contains two
XML files.
[Content_Types].xml CrmTranslations.xml
You can open the CrmTranslations.xml file with Microsoft Office Excel. When you view the data in Excel, look at the Localized Labels tab.
Graphical user interface, text, application, table, Excel Description automatically generated

Any custom tables or columns will have empty cells for the localizable text. Add the localized values for those items.
Step 4: Import translations. Import the localized text
Importing the text requires compressing the files and importing them into the system. Import the files
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From the same unmanaged solution that you exported the translations from, in the menu choose Translations > Import Translations.
Note: If you have customized table or column text, such as column labels or drop-down list values, you can provide the users in your environment who are not
working with the base language version of your environment with this customized text in their preferred languages.
The process has the following steps:

 Enable other languages for your environment

 Export the localizable text

 Get the localizable text translated

 Import the localized text
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/translate-localizable-text 

NEW QUESTION 51
- (Exam Topic 3)
You are creating a business rule to implement new business logic.
You must apply the business logic to a canvas app that has a single screen named Screen1. You need to configure the scope for the business rule.
Which scope should you use?

A. All Forms
B. Entity
C. Screen1
D. Global

Answer: B

Explanation: 
Note: Some terminology has changed. Entity is now Table. If you're building a Canvas app, you must use table (entity) as the scope.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 55
- (Exam Topic 3)
Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. List view of the entity
B. Microsoft Visual Studio
C. Templates area
D. Maker portal

Answer: A

Explanation: 
Edit a public or system view in app designer
You can change the way a public or system view is displayed by adding, configuring, or removing columns.

 In the Views list for a table, select the Show list of references down arrow Drop Down. Edit View.Graphical user interface, application Description automatically
generated

 Next to the view you want to edit, select Open the View Designer Open view Designer. The view opens in the view designer.
When you edit a public or system view, you must save and publish your changes before they will be visible in the application.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 56
- (Exam Topic 3)
A company has a Power Apps app.
The app must meet the following requirements:
• Managers assign lead records to the sales department. A new phone call record must be created if a lead record has no activities.
• An email must be sent to the manager if the phone call record created is not completed after one day. A classic workflow must run when a lead record is
assigned.
You need to configure the check conditions for the workflow. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 61
- (Exam Topic 3)
The app needs to store temporary data
• Each screen must maintain a separate copy of data and pass the data to another screen.
• The app must be able to update separate rows of a table independently. You need to configure variables for the data.
Which variable types should you use? To answer, drag the appropriate variable types to the correct requirements. Each variable type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated with medium confidence

NEW QUESTION 63
- (Exam Topic 3)
A bank uses Power BI visualizations to help determine whether they should loan money to a customer. The bank has three different visuals that are part of a
Power BI report. The bank uses a set of four risk variables that indicate whether the customer is creditworthy.
You must create a mechanism so that bank employees can change the values of the four risk variables. Changes to the value of any variable must cause the three
visualizations to update.
You need to create the solution.
Which action should you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Embed a Power BI report in a model-driven app
You can embed a Power BI report in a model-driven app main form. Box 2: Use the Power BI service.
The Power BI cloud service works with Microsoft Dataverse apps to provide a self-service analytics solution. Power BI automatically refreshes the app's data
displayed. With Power BI Desktop or Microsoft Excel, Power Query for authoring reports and Power BI for sharing dashboards and refreshing data from model-
driven apps,
your users have a powerful way to work with your app's data.
Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/embed-powerbi-report-in-system-form
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/use-power-bi
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NEW QUESTION 67
- (Exam Topic 3)
You manage Dynamics 365 for a company.
You must prevent users from launching and using Power Automate. You need to hide the Flows button on the user interface.
Which configuration setting should you change?

A. the Customizations section of System Settings
B. the Site Map
C. the Buttons tab of Flow
D. the Entity component of the default solution

Answer: A

Explanation: 
Reference:
https://www.inogic.com/blog/2018/10/show-or-hide-microsoft-flow-button-in-dynamics-365/

NEW QUESTION 68
- (Exam Topic 3)
A company uses a Power Apps app with Microsoft Dataverse.
The company requires the import of records into Dataverse. Duplicate records in the data must be deleted without user intervention.
You create a duplicate detection rule.
You need to configure the rule for the data import. Which option should you configure?

A. Enable the Templates for Data Import option.
B. Enable the When a record is created or updated option.
C. Disable the Allow Duplicates option.
D. Enable the During data import option.

Answer: D

Explanation: 
When configuring a duplicate detection rule in Power Apps with Microsoft Dataverse, to automatically delete duplicate records during a data import, you should
enable the "During data import" option. This option allows the detection rule to automatically delete duplicates as they are imported into the system, without
requiring user intervention.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/create-duplicate-detection-rule

 https://docs.microsoft.com/en-us/power-platform/admin/data-integration-duplicate-detection 

NEW QUESTION 71
- (Exam Topic 3)
A company plans to create an app by using Power Apps. The company has the following requirements:
• The app must be able to enter data into Microsoft SharePoint
• Users must be able to add the app into Microsoft Teams.
You need to recommend which app to create. Which type of app should you recommend?

A. model-driven app as a personal app
B. canvas app as a personal app
C. canvas app as a tab app
D. model-driven app as a tab app

Answer: B

NEW QUESTION 76
- (Exam Topic 3)
A company uses Common Data Service to store sales data.
For the past few quarters, the company has experienced a decrease in sales revenue. The company wants to improve sales forecasting.
The company plans to use Al Builder to implement the solution. You select fields that will be used for prediction.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, application Description automatically generated
Step 1:
Before you can use your prediction model, you have to train it to perform the way you want. Step 2:
After you train your model, publish it to make it available.
Publish your model when you want to make it available to users in your Power Apps environment. Step 3: Use the model with Power Apps
Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-train-model

NEW QUESTION 79
- (Exam Topic 3)
A company is creating a canvas app and a model-driven app to manage their customer accounts.
The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
You need to configure the scope for the business rules.
Which scope should you use? To answer, drag the appropriate scopes to the correct business rules. Each scope may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Table
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The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
Scope the business rule to Entity (Table). Box 2: Specific form
The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
For Model
The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:
If you select this item... The scope is set to...
Entity- The table and all forms for the table All Forms- All forms for the table
Specific form (account Main Form, for example) - Just that form
Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rules-recommendations

NEW QUESTION 80
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable OneDrive for Business.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 81
- (Exam Topic 3)
You are customizing a model-driven app for a company. You create a Theme template to ensure the company logo and colors are properly used within these
apps.
The theme must meet the following requirements:

 Updated to add the logo

 Downloaded by the makers to create the app
You need to configure the assets. To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Upload the theme elements as new web resources.
Each type of icon is stored as a web resource. Create a web resource first and then set the icons to use them. Alternatively, you can add the icon by creating a
new web resource when you define the table properties.
Box 2: Replace an existing UI item's hexadecimal number. Copy and alter the existing theme
The easiest and quickest way to create a new theme is to clone and alter an existing theme. Then save, preview, and publish it.

 Sign in to Power Apps, select Settings icon (upper right), and then select Advanced settings.

 Select Customizations, and then select Themes.

 Under All themes, select the theme you want to clone, such as the CRM Default Theme. Select Clone on the command bar.

 Replace an existing UI item's hexadecimal number, such as the Title Text Color, with the hexadecimal value that represents the color you want.
For example, the CRM Default Theme was cloned and changed using mostly varying shades of green color. The following screenshots show the new colors for
navigation and highlighting. A custom logo was also added that will appear in the upper left corner of an app.
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Reference:
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 86
- (Exam Topic 3)
You are implementing a model-driven app to support a new line of business. There are several places where automated business logic must be applied. You need
to determine how to apply the business logic.
Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Business rule
By combining conditions and actions, you can do any of the following with business rules:

 NSE5_FSM-5.2 Set column values

 Clear column values

 Set column requirement levels

 Show or hide columns

 Enable or disable columns

 Validate data and show error messages

 Create business recommendations based on business intelligence. Box 2: Real-time workflow
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Real-time workflows:
Graphical user interface, text, application, email Description automatically generated

Box 3: Power Automate instant flow
Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow
button in the mobile app.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-a https://docs.microsoft.com/en-
us/powerapps/maker/data-platform/configure-workflow-steps https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-
automate-and-ho

NEW QUESTION 88
- (Exam Topic 3)
A customer uses Power Apps to view and maintain their contacts that are stored in Microsoft Dataverse. Several columns must be configured to ensure the
security settings for sales associates are view only. You need to configure the access restrictions.
Which component for field-level security should you use? TO answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated

NEW QUESTION 89
- (Exam Topic 3)
You create a model-driven app for an automobile parts help desk.
A help desk agent uses a form to gather information about customers' automobiles in two custom tables. The names of the tables are Client and Automobile,
The form must prepopulate the following information about the customer from the client table:
• First name
• Last name
The agent must be able to type the following information about the automobile:
• Automobile make
• Automobile model
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You need to implement the form.
What should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 94
- (Exam Topic 3)
A company is updating a Power Apps solution that contains two tables named Sen/ices and Equipment. The company is creating a new solution to update the
current solution for the following requirements:
• The Services table must be updated to include change tracking.
• The Equipment table must be updated to include four new columns.
• The solution must update only the components that need to be added or changed. You need to create the solution.
Which table option should you use? To answer, drag the appropriate options to the correct tables. Each option may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Select components Option for Services Table Select components Option for Equipment Table
The "Select components" table option allows you to update specific components of a table, such as adding new columns or change tracking, while keeping the
existing data and relationships in the table intact. This meets the requirement that the solution must update only the components that need to be added or
changed.
You can use the Power Apps maker portal and navigate to the Environment, then click on the Data tab, select the table you want to update and click on the
settings icon and then select "Select components" from the options. Then you can select only the columns you want to add or update for each table.
This way, you can ensure that the solution will update only the necessary components for each table, including change tracking for the Services table and four new
columns for the Equipment table, without affecting the existing data and relationships in the tables.
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NEW QUESTION 95
- (Exam Topic 3)
A company is configuring a Power Apps portal using Microsoft Dataverse. The company requires the following:

 Only authenticated users must be able to sign into the portal.

 Authenticated users must have varying degrees of access to the different parts of the portal.

 Users must enter one of several external identities when creating an account during the open registration process.
You need to configure user authentication and permissions.
Which component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Contact table record
In Power Apps portals, each authenticated portal user is associated with a contact record in Microsoft Dataverse.
Box 2: Web roles
Portal users must be assigned to web roles to gain permissions beyond unauthenticated users. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-portal-authentication

NEW QUESTION 98
- (Exam Topic 3)
You are designing the organization structure for a company that has 5,000 users.
You need to configure security roles for the company while minimizing administrative effort. What should you do? To answer, select the appropriate options in the
answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Create a new team, and the business unit users, and the assign the security role to the team. Change the business unit for a team
Important
By changing the business unit for a team, you can remove all security role assignments for the team. At least one security role must be assigned to the team in the
new business unit.

 Select an environment and go to Settings > Users + permissions > Teams.
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 Select the checkbox for a team name.

 Screenshot selecting a team.

 On the menu bar, select Change Business Unit.

 In the Change Business Unit dialog box, select a business unit. Enable Move records to new business unit to move to a new business unit. Select OK.
Box 2: Grant the user a security role from the child business unit.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/create-edit-business-units https://docs.microsoft.com/en-us/power-platform/admin/security-roles-
privileges

NEW QUESTION 100
- (Exam Topic 3)
You are configuring a new Power Apps portal. You have two web roles, one for authenticated users and one for anonymous users. You grant the Anonymous
Users role to users.
A test user reports that they can access the home page but cannot view a page linked from the home page. You need to determine why the test user cannot view
the portal page.
What is the cause of the issue?

A. Maintenance mode is enabled on the portal.
B. The setting to make the page available to everyone is disabled.
C. The Authenticated Users Web role does not have permission to view the page.
D. Inherited permissions are not enabled for the linked page.

Answer: D

Explanation: 
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/webpage-access-control 

NEW QUESTION 103
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

 0 - 17

 18 - 25

 26 - 35

 36 - 55

 55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use age for Identify in the question and then
add branches for each group that use conditional logic.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead, create a custom Age group entity and synonyms for each individual age in the corresponding item. Use Age group for Identify in the question.
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.
To do this, you need to create a custom entity. Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling 

NEW QUESTION 108
- (Exam Topic 3)
A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.
The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.
Which expression should you use?

A. Option A
B. Option B
C. Option C

Answer: C
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Explanation: 
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value’],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 112
- (Exam Topic 3)
The owner of a company needs to know who signs into the system. You need to ensure that the owner can view the user audit logs.
Where does each action need to be performed? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/audit-data-user-activity

NEW QUESTION 116
- (Exam Topic 3)
You make the following customizations to a Microsoft Dataverse Environment
• Create a new table
• Add data to the new table.
• Delete an unused area from the site map.
The components must be transported to a different environment.
You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 119
- (Exam Topic 3)
You plan to automate several different processes by using Power Automate. Each process has unique characteristics.
You need to recommend components for each process.
Which components should you recommend? To answer, drag the appropriate components to the correct processes. Each component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1: Custom connector (REST API access) 2: Unatteded UI flow

NEW QUESTION 121
- (Exam Topic 3)
A company uses Microsoft Teams. You plan to create a Power Apps app for Microsoft Teams. You need to determine the environment that will used by the app.
Which environment will the app use?

A. An existing Dataverse environment that you select.
B. An existing Dataverse for Teams environment that you select.
C. A Dataverse environment that is automatically created for the team.
D. A Dataverse for Teams environment that is automatically created for the team.

Answer: D

Explanation: 
The Dataverse for Teams environment is automatically created for the selected team when you create an app or bot in Microsoft Teams for the first time or install a
Power Apps app from the app catalog for the first time. The Dataverse for Teams environment is used to store, manage, and share team-specific data, apps, and
flows. Each team can have one environment, and all data, apps, bots, and flows created with the Power Apps app inside a team are available from that team's
Dataverse for Teams database.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/about-teams-environment

NEW QUESTION 126
- (Exam Topic 3)
A company uses Power Apps.
Users must be able to view only the address1 columns in the Account table.
You need to ensure other address columns are not visible to users when creating views and filters. What should you do?

A. Disable the Search option for the columns.
B. Create business rules to hide the other address columns.
C. Delete the other address columns from the table.
D. Use column-level security to remove read access to all users.

Answer: D

NEW QUESTION 131
- (Exam Topic 3)
A company creates a canvas app.
The app requires users to enter their social security number. The app should only display the last four digits when the user tabs to a different column.
You need to configure the app. Which option should you use?

A. Power Fx
B. Business rule
C. Business process flow
D. Power Bl DAX

Answer: A

NEW QUESTION 134
- (Exam Topic 3)
You implement an editable grid for the Account entity.
The business team provides the following list of features that they would like you to implement:

 Group by or sort columns in the current view.

 Configure a business rule to show an error message.

 Edit values in calculated fields.

 Edit the Address composite field.
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 Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 136
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history. Solution: Change Elizabeth’s username in the user record for the app.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 137
- (Exam Topic 3)
You are a Dynamics 365 Customer Service administrator.
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Users report that the main form does not display data from other entities or allow them to edit data from other entities.
You need to embed information from other entities in the form and allow users to edit the data. Which actions should you perform? To answer, select the
appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, chat or text message Description automatically generated
Box 1: Add a quick create form
With quick create forms, your app can have a streamlined data entry experience with full support for logic defined by form scripts and business rules.
Box 2: Add a quick view
A quick view form can be added to another form as a quick view control. It provides a template to view information about a related entity record within a form for
another entity record. This means your app users do not need to navigate to a different record to see the information needed to do their work.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-quick-create-forms https://docs.microsoft.com/en-
us/dynamics365/customerengagement/on-premises/customize/create-edit-quick-v

NEW QUESTION 142
- (Exam Topic 3)
A company that manufactures medical devices uses Power Apps to manage their sales and device maintenance.
A Table named Devices in Microsoft Dataverse has a column named Status. The Status column must have a new status value of Review added to the existing
Choice values of Active and Inactive.
The table must be added to a solution to be promoted once the change is made.
Only this change must be promoted to the test environment. The changes must not be able to be changed once promoted. You need to add the change to a
solution for promotion.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 146
- (Exam Topic 3)
You are designing a Power Virtual Agents chatbot.
You observe that the environment you plan to use does not appear as an option in the Power Virtual Agents user interface.
You need to ensure that you can create the chatbot in the environment that you want to use. What should you do?

A. Create an environment in a supported region.
B. Convert the environment to a sandbox environment.
C. Change the region for the environment.

Answer: A

Explanation: 
The environment doesn't show up in the drop-down menu of Power Virtual Agents
Your environment might not show up in the drop-down menu due to one of the following:
The environment doesn't have a database created. To resolve this issue, go to admin.powerplatform.com to create a database in your environment.
The environment is created in an unsupported region.
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/environments-first-run-experience

NEW QUESTION 150
- (Exam Topic 3)
You are designing a chatbot for a sports outlet. You need to complete the chatbot.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Entities
Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs,
such as age, colors, numbers, and names.
With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.
Box 2: Topics
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes –
these are what you use to define how a bot should respond and what it should do.
Box 3: Variables
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
For example, you can save a customer's name in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-
topics
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

NEW QUESTION 153
- (Exam Topic 3)
You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles
B. Manage Roles
C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation: 
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 References:
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.
* 1. Go to Settings > My Apps.
* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.
* 3. Enter the following in the Manage Roles dialog box:
a) App URL Suffix
b) Roles
c) Select Save.
* 4. Refresh the My Apps page.
* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

NEW QUESTION 154
- (Exam Topic 3)
You are designing a canvas app that connects to Common Data Service.
You need to configure the app to meet the requirements and ensure that the canvas app is available offline. What should you implement? To answer, select the
appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/offline-apps

NEW QUESTION 158
- (Exam Topic 3)
A company uses a model-driven Power Apps app in a new environment. The base language is English. You need to configure French and Spanish.
Which configuration component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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Box 1: Language packs
Before users can start using a Language Pack to display a language, the Language Pack must be enabled in your organization.
Box 2: Environment Enable the language
These settings can be found in the Microsoft Power Platform admin center by going to Environments > [select an environment] > Settings > Product > Languages.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/enable-languages

NEW QUESTION 161
- (Exam Topic 3)
You are using Power BI to build a dashboard for a company.
You must make the dashboard available to a specific set of users, including employees and five external users. The number of employees that require access to
the dashboard varies, but usually less than 100. Employees and external users must not be permitted to share the dashboard with other users.
You need to share the dashboard with the employees and external users.
Which three actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Create a dynamic distribution lis
B. Add all users to the distribution group and use the list to share the dashboard.
C. Sign into the Power BI servic
D. Open the dashboard and select Share.
E. Enter the individual email address of internal and external users.
F. Sign into Power BI Deskto
G. Open the dashboard and select Share.
H. Clear the Allow recipients to share your dashboard (or report) option.
I. Create a distribution grou
J. Add all users to the distribution group and use the list to share the dashboard.

Answer: BEF

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 163
- (Exam Topic 3)
You have a model-driven app. You create five Microsoft Excel templates for analyzing customer data. Four of the templates must be available to all users. The
remaining template must be available only to you.
You configure the appropriate security roles for users.
You need to determine how to upload the Excel templates.
Which method should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Table Description automatically generated with medium confidence
Box 1: In the Settings menu, select Document Templates
Templates uploaded from the Settings page are available to all users. You don't need to take any further action. Administrators can use the Settings page to
upload the Excel template. A template uploaded in Settings is
available to all users.
For admins: Upload the Excel template

 Go to Settings > Templates > Document Templates.

 Click Upload Template.

 Drag the Excel file into the dialog box or browse to find and upload the file.

 Upload Template dialog box.

 Click Upload.
Box 2: In the view for the email records, select Excel templates
Note: For non-admins or admins wanting to create a personal template: Upload the Excel template
Open a page with a list of records, for example, the list of Sales Opportunities. Go to Sales > Opportunities > My Open Opportunities.

 On the menu bar, click Excel Templates > Create Excel Template.
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 Click Excel Template > Upload.

 Click Upload to add the Excel template.

 Drag the file into the dialog box or browse to find and upload the file.

 Click Upload.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/analyze-your-data-with-excel-templates

NEW QUESTION 167
- (Exam Topic 3)
You plan to create a canvas app.
The app requires a button on the data entry screen that users can select to send an email. You need to configure the app.
What should you create?

A. Business process flow
B. Azure Logic App
C. Power Automate cloud flow
D. Classic workflow

Answer: C

NEW QUESTION 171
- (Exam Topic 3)
A company uses a model-driven app. The app uses a workflow to send email. Emails are sent to new customers that enter an email address for the first time in the
app.
Customers report that they do not receive an email after entering an email address. You need to troubleshoot the issue.
In which order should you perform the actions? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 174
- (Exam Topic 3)
You create workflows to automate business processes.
You need to create a workflow that automatically sends emails based on a mail merge template. The workflow must contain the following configurations:

 Run immediately.

 Validate when a condition is met.

 Perform an action when a condition is met.
To answer, select the appropriate configuration in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated

NEW QUESTION 177
- (Exam Topic 3)
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen. You need to implement an action that selects the next screen that the
user sees.
Which event should you handle?

A. OnLoad
B. OnCheck
C. ScreenTransition
D. OnSelect

Answer: D

Explanation: 
 Add navigation
* 1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
* 2. With the arrow still selected, select the Action tab, and then select Navigate.
* 3. The OnSelect property for the arrow is automatically set to a Navigate function.

* 4. When a user selects the arrow, the Target screen fades in.
* 5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
* 6. Navigate(Source, ScreenTransition.Fade)
* 7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

NEW QUESTION 178
- (Exam Topic 3)
You create a Power Virtual Agents chatbot to reduce the number of incoming support calls that require a live person.
The chatbot does not direct users to the correct information. You determine that this is because the chatbot is not able to identify which product a user is referring
to in a conversation.
You need to present a list of products so that users can select the correct product. What should you create?

A. Table
B. Variable
C. Slot filling
D. Entity

Answer: C

Explanation: 
Slot filling is a natural language understanding concept that means saving an extracted entity to an object. However, in Power Virtual Agents, slot filling means
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placing the extracted entity value into a variable.
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 182
- (Exam Topic 3)
You create a Power Virtual Agents bot.
You observe that the bot is not able to recognize input from some users. You need to configure the bot response for unrecognized input from users.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Transfer to an agent.
B. Use a fallback topic.
C. Display a system-defined error message.
D. Connect to a different channel.

Answer: BC

Explanation: 
* B. Use a fallback topic: Power Virtual Agents provides the capability to handle unrecognized inputs by using fallback topics. A fallback topic is a topic that is
triggered when the bot is unable to recognize the user input. You can configure fallback topics by going to the Power Virtual Agents portal, and then select the bot
you want to configure. Then select the "Topics" tab and create a new topic with a fallback trigger. Reference: https://docs.microsoft.com/en-us/power-virtual-
agents/topics-triggers#fallback-triggers
* C. Display a system-defined error message: This is another option to handle unrecognized inputs by displaying a predefined message that inform the user that
the bot was unable to understand their input.

NEW QUESTION 187
- (Exam Topic 3)
You ate a Dynamics 365 Customer Engagement administrator. You create workflows to automate business processes. You need to configure a workflow to meet
the following requirements:
• Be triggered when a condition is met.
• Run immediately.
• Perform an action when a condition is met.
How should you configure the workflow? To answer, select the appropriate configuration in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1) Be triggered when a condition is met - Subject contains data
2) Run Immediately - Configure the workflow to run now
3) Perform an action when a condition is met - send an email

NEW QUESTION 188
- (Exam Topic 3)
You create a Power Apps portal to provide training and documentation for students. Students create a profile on the portal and then select and pay for courses.
You plan to add free courses to the training portfolio. Free courses must be automatically available to all students when they sign in.
You need to assign default permissions to students. What should you do?

A. Create an entity for managing free course
B. Create a Students web role and set the Authenticated Users role option to tru
C. Create appropriate entity permissions to access the free course entity records and assign the entity permissions to the web role.
D. Create an entity for managing free course
E. Create entity permission records to provide access to entity records for free courses and assign the entity permissions to users when they register on the portal
for the first time.
F. Create a Students web role and set the Authenticated Users Role option to tru
G. Assign the web role to each registered user.

Answer: C

NEW QUESTION 192
- (Exam Topic 3)
A user has access to an existing Common Data Service database.
You need to ensure that the user can create canvas apps that consume data from Common Data Service. You must not grant permissions that are not required.
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Which out-of-the-box security role should you assign to the user?

A. Environment Admin
B. System Customizer
C. Common Data Service User
D. Environment Maker

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/database-security#predefined-security-roles https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/data-platform-create-app

NEW QUESTION 196
- (Exam Topic 3)
You create a report by using Power Bl Desktop and publish the report to the Power Bl service. You enable Power Bl visualization embedding in a model-driven
app.
You need to configure the model-driven app to display a Power Bi tile
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
1) Pin the Power BI report to a new dashboard in the Power BI service
2) Create a personal dashboard in the model-driven app (as Power BI dashboards are always personal dashboards (that can be shared))
3) Add a power BI tile to the dashboard and select the Power BI dashboard in the app.

NEW QUESTION 199
- (Exam Topic 3)
A company plans to create a Power Virtual Agents chatbot. The bot has the following requirements:
• Prompt for a location of the customer and the call must be routed to a support agent for the location.
• Transfer support calls at each location to a support bot that uses the Bot Framework. You need to configure the bot.
Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct select is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 

NEW QUESTION 202
- (Exam Topic 3)
A company uses three apps to complete several business processes.
You need to identify solutions to help the company perform regression testing when the apps are updated. Which two tools should you use? Each correct answer
presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Power Automate automated flow
B. Windows recorder (V1)
C. Power Automate desktop flow
D. Windows Steps Recorder

Answer: BD

NEW QUESTION 207
- (Exam Topic 3)
A company creates a Power Automate cloud flow for a Power Apps app.
The cloud flow must send a daily email that contains a list of year-to-date (VTD) totals. You need to configure the flow.
Which feature should you use?

A. Parallel branch
B. Loop
C. Condition
D. Wait

Answer: B

Explanation: 
In order to send a daily email that contains a list of year-to-date (YTD) totals, you would need to use a loop in the Power Automate cloud flow. A loop allows you to
repeat a specific set of actions until a certain condition is met. In this case, the loop would be used to iterate through the data for each day, accumulating the totals
for the year-to-date (YTD) and then sending the email at the end of the loop with the accumulated totals.
Here are some references from Microsoft that may be helpful in understanding how to use loops in Power Automate:

 Microsoft docs: Loops in Power Automate

 Microsoft docs: Repeating a flow with a loop

 Microsoft docs: Using the do-until loop in Power Automate

NEW QUESTION 212
- (Exam Topic 3)
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming,"
or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-releva

NEW QUESTION 213
- (Exam Topic 3)
You need to embed the FAQbot into the communication solution.
Which actions should you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 214
- (Exam Topic 3)
You are creating a new business process flow to qualify leads.
You create an action. The action is not available inside the Action Step. You need to make the action available to the Action Step.
Which two steps must you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Activate the action.
B. Select Run as an on-demand process
C. Add at least one step to the action.
D. Ensure that the entity for the action matches the corresponding entity for the business process flow stage.

Answer: CD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/business-applications-release-notes/april18/microsoft-flow/add-action-business

NEW QUESTION 216
- (Exam Topic 3)
A company deploys a chatbot that is embedded in a Power Pages website. The company has the following requirements for the chatbot:
• Azure AD users only must be able to use the chatbot when accessing sensitive data.
• The chatbot must be accessible only from the Power Pages website. You need to recommend a solution that meets the requirements.
Which two options should you recommend? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable Manual authentication.
B. Set up a new channel for the chatbot.
C. Enable Only for Teams authentication.
D. Enable web channel security.
E. Configure a data loss prevention policy.

Answer: DE

NEW QUESTION 221
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- (Exam Topic 3)
You are configuring Microsoft Dataverse security. You plan to assign users to teams. Record ownership and permissions will differ based on business
requirements.
You need to determine which team types meet the requirements.
Which team type should you use? To answer, drag the appropriate team types to the correct requirements.
Each team type may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Microsoft Teams team
Dataverse supports two types of record ownership. Organization owned, and User or Team owned. This is a choice that happens at the time the table is created
and can’t be changed. For security purposes, records that are organization owned, the only access level choices is either the user can do the operation or can’t.
For user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or
only the user’s own records. That means for read privilege on contact, I could set user owned, and the user would only see their own records.
Box 2: Access team
An access team doesn’t own records and doesn’t have security roles assigned to the team. The team members have privileges defined by their individual security
roles and by roles from the teams in which they are members. The records are shared with an access team and the team is granted access rights on the records,
such as Read, Write or Append.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/use-access-teams-owner-teams-collaborate

NEW QUESTION 223
- (Exam Topic 3)
A company has a custom website.
You need to embed a Power Virtual Agents chatbot into the website. What should you use?

A. Webpage URL
B. Form ID
C. Bot ID
D. IFrame

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels

NEW QUESTION 228
- (Exam Topic 3)
You create functionality for a company. The functionality includes a Microsoft Dataverse table with a form for data entry. The functionality will be distributed to other
lines of business in the company, each with its own Dataverse environment.
New forms must not be created in order for updates to the functionality to work correctly. You need to package the new functionality for distribution.
What should you do?

A. Use a patch solution and disable the ability to create new forms for the table.
B. Use a managed solution and include only the needed form.
C. Use an unmanaged solution and include only the needed form.
D. Use a managed solution and disable the ability to create new forms for the table.

Answer: B

Explanation: 
Managed solutions are used to deploy to any environment that isn't a development environment for that solution. This includes test, UAT, SIT, and production
environments. Managed solutions can be serviced independently from other managed solutions in an environment. As an ALM best practice, managed solutions
should be generated by exporting an unmanaged solution as managed and considered a build artifact. Additionally:
You can't edit components directly within a managed solution.
Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm
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NEW QUESTION 230
- (Exam Topic 3)
You need to recommend a role for users to perform several required tasks. The solution must use the principle of least privilege.
Which roles should you recommend? To answer, drag the appropriate roles to the correct functions. Each role may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Box 1: Office 365 Global Administrator
You may think that the Dynamics 365 system administrator would have power to do all the actions needed to manage Dynamics 365, but this is not the case.
What's different in Microsoft cloud deployments is that licenses and user accounts are managed in Office 365 by an Office 365 Global Administrator. This role is
analogous to a network administrator for an on premises deployment. The Global Administrator is the only role to create new user accounts and assign
subscription licenses for Dynamics 365 (and other Office 365 apps such as Skype, Power BI and SharePoint).
Box 2: Dynamics 365 system administrator
The Dynamics 365 system administrator may assign roles and permissions to the Dynamics 365 user within an instance of Dynamics 365. The Dynamics 365
system administrator also controls all the settings in Dynamics 365.
Box 3: Dynamics 365 admin
The Dynamics 365 admin can perform backups and restores. Reference:
https://docs.microsoft.com/en-us/power-platform/admin/use-service-admin-role-manage-tenant
https://community.dynamics.com/crm/b/govandthecity/posts/understanding-dynamics-365-and-office-365-admi

NEW QUESTION 231
- (Exam Topic 3)
You must create a new entity to support a new feature for an app. Entity data will be transactional and will be associated with business units.
You need to configure entity ownership. Which entity ownership type should you use?

A. user or team owned
B. organization-owned
C. none
D. business-owned

Answer: A

NEW QUESTION 235
- (Exam Topic 3)
You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.
The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable server-based SharePoint integration.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
 References:
https://docs.microsoft.com/en-us/power-platform/admin/set-up-dynamics-365-online-to-use-sharepoint-online

NEW QUESTION 238
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.
Solution: Use Datavserse Search to search for the word run. Does the solution meet the goal?
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A. Yes
B. No

Answer: B

NEW QUESTION 242
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: Delete the user account in the Power Platform admin portal and recreate the account by using the new name.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 244
- (Exam Topic 3)
You are a Dynamics 365 Customer Service help desk administrator.
Cases entered in forms require different types of data to be stored in different types of fields. You need to create forms for each of the following case types:

Which form types should you create? To answer, drag the appropriate form types to the meet the data entry requirements. Each source may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/create-design-forms-customer-service-hub

NEW QUESTION 247
- (Exam Topic 3)
You are designing a Power Virtual Agents chatbot for a store.
You need to teach the chatbot to acknowledge the store's product categories and the variations within specific categories.
You need to create custom entities to provide the chatbot with the knowledge of the product categories. Which features should you use? To answer, select the
appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

Smart match Synonyms Topic
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 249
- (Exam Topic 3)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: Ask the Microsoft 365 administrator to sign in to the admin portal and change the username. Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 252
- (Exam Topic 3)
You are creating a Power Virtual Agents chatbot for a Microsoft Power Platform power apps portal app. The job title of users must be stored automatically when
users log in. The job title must always appear in the
chatbot.
You need to configure the job title functionality.
Which mechanism should you use?

A. artificial intelligence
B. variable
C. entity
D. topic

Answer: B

Explanation: 
After enabling the Authentication, you will now have access to Two variables, bot.UserDisplayName
bot.UserId
Reference:
https://powerusers.microsoft.com/t5/Power-Virtual-Agents-Community/Getting-User-Details-To-Use-In-Power

NEW QUESTION 253
- (Exam Topic 3)
The business team provides the following list of features that they would like you to implement:
• Group by or sort columns in the current view.
• Configure a business rule to show an error message.
• Edit values in calculated fields.
• Edit the Address composite field.
• Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 255
- (Exam Topic 3)
You have a business process flow (BPF) that interacts with the Account entity. You configure a new version for the BPF and add a new stage at the beginning.
You need to identify the impact of the new version on the existing account records.
What is the outcome in each scenario? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text Description automatically generated
Box 1: Existing accounts show the new BPF.
When an entity record is being created and if there are multiple BPFs defined on that entity. The system would do the following:
If the ProcessId field is set to Guid.Empty. The system will skip defaulting the BPF on that instance.
If the ProcessId field is set to specific BPF entity reference. The system will default to the specified BPF. If the ProcessId field on the record is not set. The system
will default the BPF.
Box 2: No BPF is linked to a new account.
Note: A business process flow definition is represented as a custom entity and an instance of a process is stored as a record within that entity. Each record is
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associated with a data record (such as an Account, Contact, Lead, or Opportunity) and in case of cross-entity processes, with a data record for each participating
entity.
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/business-process-fl

NEW QUESTION 258
- (Exam Topic 3)
A car dealership has a Dynamics 365 Sales environment for its sales company and another environment for its leasing company. Users in one environment must
not be able to see the other environment. You need to grant salespeople access to the sales company environment. What should you do?

A. Add salespeople to a security role.
B. Set privileges.
C. Add salespeople to an Office 365 security group.
D. Set app security

Answer: C

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 260
- (Exam Topic 3)
You are a Dynamics 365 for Customer Service developer.
You must trigger a mobile notification whenever a specific hashtag is posted from Twitter. The notification will send email to the company’s social media teams
distribution list.
You need to create a connection to the Twitter service and build a solution.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 262
- (Exam Topic 3)
A company creates a canvas app.
The app requires near real-time data from an accounting system that resides in a customers data center. You need to implement a solution for the app.
What should you create?

A. Azure DevOps pipeline
B. On-premises data gateway
C. Power Pages
D. Data integration project

Answer: B

Explanation: 
When a company creates a canvas app that requires near real-time data from an accounting system that resides in a customer's data center, one solution that can
be implemented is to create an On-premises data gateway.
An On-premises data gateway is a service that allows Power Apps to connect to and access data sources that are located on-premises, such as the accounting
system in the customer's data center. The gateway acts as a bridge between the cloud-based Power Apps and the on-premises data sources, enabling real-time
data transfer and integration.
References:

 https://docs.microsoft.com/en-us/power-platform/admin/gateway-reference

 https://docs.microsoft.com/en-us/power-platform/admin/gateway-onprem

 https://docs.microsoft.com/en-us/power-platform/admin/real-time-data-integration

NEW QUESTION 266
- (Exam Topic 3)
You create and publish a Power Bl report that contains an embedded canvas app. The report will be used by multiple people.
The canvas app has an issue that must be corrected. You update the canvas app.
You need to ensure that the updated canvas app is available in the published Power Bl report. What should you do?

A. Publish the Power Bl report from Power Bl Desktop.
B. Manually refresh the data source on the published Power Bl report.
C. Publish the Power Bl report from Power Bl Desktop and reshare to any users.
D. Publish the canvas app.

Answer: B

Explanation: 

 If you change the data fields associated with the visual, you must edit the app from within the Power BI service by selecting the ellipsis (...) and then selecting
Edit. Otherwise, the changes won't be propagated to Power Apps, and the app will behave in unexpected ways.

 The Power Apps visual can't trigger a refresh of Power BI reports and Power BI data sources from within Power BI Desktop. If you write back data from the app
to the same data source as the report, your changes won't be reflected immediately in Power BI Desktop. Changes are reflected on the next scheduled refresh.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/powerapps-custom-visual#limitations-of-the-po

NEW QUESTION 268
- (Exam Topic 3)
A company is implementing a data model by using Dataverse.
The company requires the following columns in a new custom table:
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You need to choose the column type that uses the least amount of database storage for each column.
Which column types should you choose? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 273
- (Exam Topic 3)
The sales manager receives a list of leads from a partner company monthly. The field names that are provided do not match the fields in Dynamics 365. A data
map does not exist.
You need to import the leads without changing the data from the partner company. What should you do?

A. Create a data map in Data Management.
B. Add a template for Import Data.
C. Use Import Field Translations.
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D. Create a data map on the first import by using the Import Data wizard.

Answer: D

Explanation: 
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/basics/import-accounts-leads

NEW QUESTION 278
- (Exam Topic 3)
You create a Power Automate flow as part of a managed solution. The flow alerts users when files are uploaded to a SharePoint location.
Files are uploaded to SharePoint at a much higher rate than expected. Users report that they receive too many notifications about uploaded files.
You need to stop the flow and correct the issue.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application Description automatically generated
Reference:
https://docs.microsoft.com/en-us/power-automate/edit-solution-aware-flow https://docs.microsoft.com/en-us/power-automate/error-checker

NEW QUESTION 283
- (Exam Topic 3)
You are a Dynamics 365 Customer Service developer. A salesperson creates a chart.
You need to ensure that the chart is available to all users on the team.
Which actions should the salesperson perform? To answer, drag the appropriate actions to the correct users. Each action may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 288
- (Exam Topic 3)
A company’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.
You need to provide a solution for each requirement.
Which solutions should you provide? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Graphical user interface, text, application, email Description automatically generated
Box 1: Add a Kanban control.
The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.
Box 2: Add both controls to the My Opportunities view.

 Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so
salespeople can use the Kanban views.The Kanban control works only on the Opportunity and Activity entities.

 If you use unified interface, you can display any record in a calendar view via the calendar control.
- Go to Settings->Customization->Customize the System
- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)
- Click the View tab
- Click “Add Control” and select the calendar control.
- Click the dot for every interface from which you want the calendar control to be available.
Box 3: Use a List view
opportunities in Dynamics 365 Sales
Reference:
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave1/dynamics365-sales/work-opportunities- https://crmtipoftheday.com/1206/view-any-
dynamics-365-record-on-a-calendar/
https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-cod

NEW QUESTION 290
- (Exam Topic 3)
A user needs to create a Power Apps portal app.
The user is getting a permission denied error when creating the portal app.
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You need to configure permissions to create the portal app.
Which three permissions should you configure? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. In the Power Platform admin center, ensure that the user account has read-write access.
B. In Azure Active Directory, assign the Contributor role to the application at the subscription scope.
C. In Azure Active Directory, ensure that the user has permission to register an app.
D. In the Power Platform admin center, change the portal app owner to the user.
E. In the Power Platform admin center, ensure that the user has the System administrator security role.

Answer: ACE

Explanation: 
Reference: https://docs.microsoft.com/en-us/power-apps/maker/portals/create-common-problems https://docs.microsoft.com/en-us/power-
apps/maker/portals/create-portal
https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-create-service-principal-portal#required

NEW QUESTION 291
......
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